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Section 1:  SEER*Abs Installation 
The registry’s first installation of SEER*Abs should be on the workstation of the registry’s 
SEER*Abs system administrator.  The system administrator will configure SEER*Abs and create a 
registry-specific installation file for you and other SEER*Abs users at the registry. 

To install SEER*Abs on your computer: 

1. The SEER*Abs software requires Java 1.6.0 or later.  Follow these steps to determine the 
version of Java installed on your computer: 

a. Enter java -version at a DOS prompt. 

b. If you do not have the required version, uninstall the existing version of Java and 
install the latest version. More information related to the appropriate version of Java 
is provided on the SEER*Abs Web site (seer.cancer.gov/seerdms/portal/seerabs). 

2. Install SEER*Abs by extracting your registry’s distribution zip file into a new folder (for 
example, c:\seerabs).  Sub-folders within seerabs.zip must be retained.  To achieve this you 
may need to set an option in your decompression software (in WinZip, “use folder names” 
must be checked). 
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Section 2:  Introduction to SEER*Abs 
Install your registry’s version of SEER*Abs on your laptop as described in Section 1.  The system 
configuration defines how patient and record data are displayed in the system, the availability of 
reference data, your username and initial password, and your Abstractor ID.  Please contact your 
registry’s IT staff for assistance with the SEER*Abs installation or to request changes to the 
configuration.   

Logging In 

Your user name and initial password were defined by your registry’s system administrator when 
SEER*Abs was configured for your laptop.  If a shortcut was created, the SEER*Abs icon  will be 
displayed on your desktop or in your system tray. 

To log in:  

1. Click the SEER*Abs icon or double-click the seerabs.exe executable file.  SEER*Abs will load 
configuration files and execute initialization scripts.  You may continue with the login 
process as these scripts are loaded and executed. 

2. Enter your username and password.  The username field will default to the username 
entered in the previous session. 

3. If your work will be related to data for one facility, you may specify the Facility on the login 
page.  The value that you specify here will be used as the Current Facility in SEER*Abs.  
This will be the default facility in the worklist and, depending on your registry’s 
configuration; it may be used as a default value for some data entry fields.  It may also be 
used in scripts that create extracts and download data from your registry database.  Consult 
the SEER*Abs system administrator at your registry to determine the ways in which Current 
Facility is used.    

a. To specify the Current Facility on the login page, enter the facility ID or use the 
lookup to search for a facility. SEER*Abs Facility IDs are the same as those in your 
central registry’s data management system.  If your registry uses SEER*DMS, you 
do not have to enter the FAC- prefix.   

b. If you are not working on data for a single facility or if you have not yet downloaded 
the facility list from your central registry’s database, you may leave this field blank.  
(Facility lists are downloaded when SEER*Abs and your registry’s database are 
synchronized.) 

4. Click Login. 

If this is your first SEER*Abs session, you will be prompted to change your password. 

1. Enter a value in Password.  Security measures to protect the confidentiality of patient data 
must include the use of strong passwords as described in Changing Your Password. 

2. Verify the new password by re-entering it into the Repeat Password field. 

3. Click OK. 
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Changing Your Password 

SEER*Abs provides access to confidential data.  It is your responsibility to protect and maintain 
your password according to registry policy.  Your registry may require that you periodically create a 
new password.  If you have forgotten your password, please contact the SEER*Abs system 
administrator at your registry.  

To change your password: 

1. Select File > Change Password. (Keyboard alternative:  use Alt-F to access the file menu 
and the down arrow key to select Change Password.) 

2. Enter your Old Password. 

3. Enter a New Password.  All passwords must be at least 8 characters in length.  Security 
measures to protect the confidentiality of patient data must include the use of strong 
system passwords.  Your password should: 

a. Include symbols, digits, and letters of both upper and lower case.  You must use at 
least one lower case letter, one upper case letter, and one digit or punctuation mark. 

b. Be significantly different from passwords that you have used in the past. 

c. Not include your name, your username, your child’s name, or your pet’s name. 

d. Not be a common word or name.  

4. Re-enter your new password in the Repeat New Password field. 

5. Click OK.  Your new password will be effective immediately. 

SEER*Abs Menus, Toolbar, and Shortcuts 

Every item on the SEER*Abs menus can be accessed via keyboard short-cuts.  In addition, items 
on the Show menu can be accessed via optional toolbar icons (select Toolbar in the Show Menu to 
toggle the Toolbar on/off).  When logged on as a standard user, the toolbar includes four items – 
Worklist, Editor, Search, and Synchronization.  The menus and tools for the standard user are 
described in this manual.  The Configuration, Users, and Log tools are only shown when logged on 
as the administrative user and are described in the SEER*Abs System Administration reference.   
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     File Menu 

Shortcut Menu Item 

Ctrl+Shift+A New Abstract – opens a blank abstract record in the editor 

Ctrl+Shift+C New Casefinding – opens a blank casefinding record in the editor. 

 New <other record types> – SEER*Abs can be configured to create records other 
than abstract and casefinding.  If your system administrator configured SEER*Abs to 
allow data entry of other record types, they will also be listed in the File menu. 

Ctrl+Shift+P Search Patient Data – opens the Patient Data tab of the Search page.  The search 
filters are reset. 

Ctrl+Shift+F Search Facilities – opens the Facility tab on the Search page.  The search filters 
are reset. 

Ctrl+Shift+Y Search Physicians – opens the Physician tab on the Search page.  The search 
filters are reset. 

Alt+F, arrows Backup Main Database – creates a backup of the data stored in the main 
SEER*Abs database.  Data entered in SEER*Abs, changes made to AFLs, and 
changes made to the user list are stored in the main database.  Reference data are 
not stored in the main database and are not included in this backup. 

Alt+F, arrows Restore Main Database – overwrites the main database using a previously created 
backup. You will be prompted to select the backup from your hard disk or network.  

 Import Reference Database – overwrites the reference database using a version 
stored on disk. You will be prompted to select the database directory from your hard 
disk or network.  This feature enables you to restore a backup reference database 
created through external processes. (SEER*Abs does not provide an internal 
mechanism for creating a backup of the reference database.) 

Alt+F, arrows Recreate Indexes – ensures that database indexes and tables are in sync.  
Indexes are used by SEER*Abs to optimize database searches.   

Recreating the indexes will ensure that the indexes and database are in sync.  It is a 
good first step to try if you notice odd results in searches or when filtering.  It should 
be very rare that this would need to be done. 

Alt+F, arrows Change Password – allows you to specify a new password. 

Alt+F, arrows Set Current Facility – allows you to change the Current Facility used throughout 
SEER*Abs.  You may select a facility or set Current Facility to none.  Current Facility 
is used as the default facility in the worklist and, depending on your registry’s 
configuration, it may be used as a default value for some data entry fields.  It may 
also be used in scripts that create extracts, download data from your registry 
database, or perform other functions.  Consult the SEER*Abs system administrator 
at your registry to determine the ways in which Current Facility is used. 

Ctrl+Shift+Q Exit – closes SEER*Abs.  You will be prompted to save any unsaved changes. 
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Show Menu 

 
Toolbar 
Icon 

Shortcut Menu Item 

 

F1 Worklist – opens or returns you to the SEER*Abs worklist.  When 
you first login, the worklist filters are set to show outstanding 
abstracting tasks (AFLs) for the current facility.  AFLs for all facilities 
will be displayed if you do not select a current facility.    

 

F2 Editor - allows you to create new records.  Abstract and casefinding 
record layouts are defined for most registries; a short abstract 
layout is supported but is only available if defined in your registry’s 
configuration. 

 

F3 Search – opens the Search page.  If you have used the Search 
page in this session, the filters and results most recently displayed 
are restored.    

Use this to search patient, facility, and physician data in the 
SEER*Abs database.  These reference data are extracted from the 
registry’s main database or loaded from external files during 
synchronization.  Scripts maintained in the registry’s Configuration 
determine the contents of the reference data.  

 

F4 Synchronization – allows users to update SEER*Abs with data 
from the registry’s data management system; and create extracts to 
update the registry’s data management system. 

 Ctrl+Shift+L Toolbar – toggles the display of the toolbar icons  

 

Action Menu 

Shortcut Menu Item 

Ctrl+Shift+H Purge Archived Dataa – deletes archived AFLs and/or records older than that are 
older than a period of time defined in registry configuration settings.  Note:  This 
feature may be hidden in your registry’s configuration. 

Alt+A, 
arrows 

Your registry’s system administrator can customize the Action menu.  Other 
actions may be listed.  If your registry’s configuration does not support any 
actions, the Action menu will not be displayed. 
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Help Menu 

Shortcut Menu Item 

Ctrl+Shift+H User Manual – displays this document. 

Ctrl+Shift+S System Administration – displays the SEER*Abs System Administration 
reference. 

Ctrl+Shift+T Shortcuts – displays a list of keyboard shortcuts.  Global shortcuts and shortcuts 
specific to the current page will be listed.  

Alt+H, 
arrows 

Coding Manuals – Some of the SEER, NAACCR, FORDS, and Collaborative 
Staging coding manuals have been distributed with SEER*Abs and can be opened 
via the Help menu. 

Alt+H, 
arrows 

About – displays system information including the installed version and credits. 

 

Status Bar 

A status bar is shown at the bottom of the screen.  The contents of the status bar are described 
below.   

• Your username and the current facility are displayed on the left side of the status bar.  The 
facility will be used as the default for filters and some fields when entering data.  If you 
need to change the facility, select File > Set Current Facility. 

• The name of the current module is shown on the far right side of the status bar.  In the 
example below, the user is viewing the Worklist and FAC-0009 is the Current Facility. 

 

• You may move back and forth from the record editor to other parts of the system without 
closing the record.  If a record is open in the editor: 

o The type of record is indicated by an ID prefix or the full record ID.  If the record has 
never been saved, only the prefix is shown.  ABS and CF are the ID prefixes for 
abstract and casefinding records.     

o Mod is displayed if the record has been modified but not saved. 

o The number of failing edits will be shown in parentheses.  

• The figure below shows the status bar as it would be displayed while editing an abstract 
record that was saved and then modified.  The modifications have not been saved.  The (1) 
indicates that there is one edit failing for the record. 
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Keyboard Commands 

To access a menu using your keyboard, press Alt + a letter.  To view the letter assigned to each 
menu, only press the Alt key.  A single letter will be underlined in each menu item.  Alt + that 
letter will open the menu.  You may then use arrow keys or the key combinations listed on the 
menu to access a specific menu item.   

In addition to the shortcuts listed in the menus and toolbar icons, there may be shortcuts designed 
specifically for the current page.  Enter Ctrl+Shift+T to view a list of the currently available 
keyboard shortcuts. 
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Section 3:  Worklist 
The SEER*Abs worklist displays tasks related to abstracting, casefinding, and data entry.  In 
SEER*Abs, abstracting tasks begin as Abstract Facility Leads (AFL) and result in the creation of 
abstract records.  An AFL is a request to abstract medical records for a patient at a specific hospital 
or facility.  The AFLs are loaded into SEER*Abs based on data from your registry’s main database.  
You will review the information in an AFL and, typically, create an abstract record for the patient.   

In addition to AFL tasks, all records created in SEER*Abs are listed as tasks in the worklist.  It is 
possible to have tasks for each type of record supported in SEER*Abs including abstract records, 
casefinding records, and records designed specifically for your registry.  The task ID includes a 
prefix which identifies the type of task.  The prefixes can be customized for your registry, if 
desired.  The prefixes used for tasks in the default version of SEER*Abs are: 

• AFL – Abstract Facility Lead.  This “lead” indicates that an abstract is needed from a specific 
facility for the patient.   

• ABS – worklist task to finish an incomplete abstract record. 

• CF – worklist task to finish an incomplete casefinding record. 

• There may be other types of tasks unique to your registry. 

 

The worklist filters and columns can be configured, the worklist in your version of SEER*Abs may 
not be exactly as shown above.  Typically, there will be filters at the top of the worklist that allow 
you to search for tasks by task type, status, facility, and other search fields.  The results of your 
search will be displayed in the table below.  When you first log in, the worklist will display the 
outstanding AFL tasks for the Current Facility. 
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Navigation Keys for the Worklist 

If you prefer keyboard navigation to using the mouse, you may use the following keys to move 
through the worklist and make selections: 

• Tab – press Tab to move from one filter to the next.  Tab will also take you from the last filter 
to the Reset button, and from the Reset button to the first task in the worklist. 

• Shift+Tab – use this to move in the reverse direction as Tab 

• Alt+Down – to view the choices in a drop-down menu 

• Arrow keys – to scroll through the choices in a drop-down menu; or to scroll through the tasks 
in the worklist. 

• Enter – If your cursor is on a filter, pressing Enter will start the search using the settings in all 
filters.  If your cursor is on the Reset button, the filters will be reset to their default values.  If 
your cursor is on a worklist task, the task will open. 

Searching the Worklist 

Search criteria are entered in filters displayed at the top of the worklist.  Your registry’s system 
administrator can configure SEER*Abs to show different filters or change the way that the searches 
are implemented.  The following describes the default configuration in the distribution version of 
SEER*Abs. 

To search for tasks in the worklist: 

1. Use the drop-down menu to select the Type of worklist task. 

a. AFL – a request for an abstract from a specific facility.  Data identifying the patient 
and the cancer of interest are defined in the AFL. 

b. Abstract, Casefinding, and Other Types of Records – The worklist includes records 
entered in your installation of SEER*Abs. These include records that were entered 
but not completed, records that were completed but not submitted to the registry, 
and records that were submitted and archived.  Archived records are available in the 
worklist until they are purged using the Action > Purge Archived Data menu item. 

c. Any – all of the above.   

2. Select the Status.  The values listed in the drop-down menu will vary based on the Type of 
task selected in step 1; you cannot filter by status if Type = Any.   Options that are 
enclosed in brackets are combinations of other values, for example <Outstanding> lists all 
open tasks for the selected data type; and <Any> lists tasks with any status for the 
selected data type. 

a. Statuses for AFL Tasks 

i. Not Processed – have not started abstracting the case 

ii. In Progress – began abstracting but did not complete the abstract 



10 6/12/2009       SEER*Abs User Manual  

 

iii. Abstracted – created a complete abstract record for the case 

iv. Not Abstracted – determined that the case should not be abstracted 

v. Archived – submitted the results of the AFL to the registry.  The status of an 
AFL is set to Archived when you export the AFL data.  Archived AFLs are 
retained in SEER*Abs for a period of time that is defined in registry 
configuration settings.  Archived data that have expired can be removed by 
selecting Action > Purge Archived Data. 

vi. Outstanding – AFL tasks that have a status of In Progress or Not Processed. 

vii. Any – All of the above. 

b. Statuses for Record Tasks 

i. In Progress – entered some but not all data in the record 

ii. Completed – entered all fields and marked the record as complete 

iii. Archived – submitted the record to the registry.  The status of a completed 
record is set to Archived when the record is exported.  Archived records are 
retained in the system for a period of time as defined in registry configuration 
settings.  

iv. Outstanding – In Progress is the only outstanding status for records. 

v. Any – All of the above. 

3. If you are searching for tasks related to a particular facility, enter a value in the Facility 
filter: 

a. If you know the facility’s ID, type the ID into the filter.  SEER*Abs Facility IDs are 
the same as those in your central registry’s data management system.  If your 
registry uses SEER*DMS, you do not have to enter the FAC- prefix.  Multiple IDs can 
be entered separated by commas.  You may press Enter to apply your changes to 
the facility filter or Tab to another filter to enter additional search criteria. 

b. Or click the Lookup  to search the database for the facility ID.   

i. Enter search text into the lookup’s filter.  The lookup table and its search 
feature are defined by registry configuration settings.  You may sort the table 
of search results by clicking a column header.   

ii. Double-click an entry to select it.  If you prefer to use keyboard controls: 

1. Press tab to move from the text search box to the list.   

2. Use the arrow keys to move through the list.   

3. Press Enter to select an entry. 
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4. The Text box is a generic, Google-style search box that can be used to search for tasks 
based on fields displayed in the worklist.  Registry-defined configuration scripts determine 
which fields are searched. 

5. Press Enter to apply the filter settings. 

You may click Reset to return all filters to their default values and reload the worklist. 

List of Tasks 

The items that match the filter settings are displayed in a scrolling table just below the filters.  The 
columns displayed in this table are controlled by the configurations set by your registry staff.  
SEER*Abs is shipped with the columns ID, last name, first name, middle initial, SSN, Medical 
Record Number, Facility, Last Modified, Linked Record/AFL, and Status.   The table can be sorted 
by clicking the column header of any column.  Click the column header a second time to reverse 
the sort order. 

A message is printed above the worklist table on the right side that shows the number of items 
displayed.  A configuration parameter determines the maximum number that will be displayed in 
the worklist (2,500 is the default setting).  A message will be displayed if the number of results 
returned by your search exceeded the display limit.   

If your search exceeded the display limit and you are looking for a particular task, it may be 
missing from the items listed.  You should add more detailed search criteria in the filters.  For 
example, if you enter a common last name into the “Text” filter and the search results exceed the 
display limit then you should search by SSN, facility, medical record number, or other search 
criteria.   

Processing an AFL 

To open and process and AFL in the worklist:  

1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.) 

2. Use the filters to search for AFLs from a particular facility or for a specific patient (see the 
Searching the Worklist section of this chapter).   

3. Use your mouse or keyboard controls to select an AFL (see the Navigation Keys for the 
Worklist section of this chapter). 

4. Double-click anywhere on the AFL’s row or press Enter to open it. 

5. The AFL will be displayed in a pop-up.  The layout of this screen is defined by your registry’s 
configuration settings.  The snapshot below is based on the configuration shipped with 
SEER*Abs.   
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6. Review the AFL and determine the appropriate action.  The Abstract button is selected, 
by default, when the AFL is first opened.  Use tab or your mouse to move from one 
button to the next.  

a. To abstract the case, press Enter or click Abstract.  SEER*Abs will open the 
abstract editor.  Data from the AFL and your abstractor ID may be auto-loaded 
into the record fields, as defined in your registry’s configuration settings.  
Instructions for entering and saving the record data are provided in the Editing a 
Record section of this document. 

b. If an abstract is not appropriate for this case, use your keyboard or mouse to 
select Not Abstract.   

i. Type a value or use the lookup to specify the Reason Not Abstracted.   

ii. Provide information specific to the case in the Detailed Explanation 
section. 

iii. Click Update AFL Status to save these changes. 

c. Search – Takes you to the Search module with the filters set for the patient 
described in this AFL.  If your registry uses reference data, this allows you to see 
if your registry has any information about this patient already. 

d. Cancel – exit the AFL without saving any changes. 
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Opening a Record in the Worklist 

To open a Record from the worklist in order to complete or review it: 

1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press 
F1.) 

2. Use the filters to search for the record as described in the Searching the Worklist section 
of this chapter.   

3. Use your mouse or keyboard controls to select a record (see the Navigation Keys for the 
Worklist section of this chapter for more information).   

4. Double-click or press Enter to open it.   

5. The record will be displayed in the editor.  Instructions for entering and saving the 
record data are provided in the Editing a Record section of this document. The editor 
might not be editable if the record has already been extracted out of SEER*Abs. 
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Section 4:  Editing a Record 
The SEER*Abs Editor allows you to create or modify records.  Records can be opened and modified 
until they are exported (status = archived); you cannot modify data once it has been archived and 
you cannot use SEER*Abs to modify records that were created by other software.  Archived records 
can be viewed in the editor in read only mode.  Archived records are completely removed from the 
SEER*Abs database when the Purge Archived Data action is used.  

SEER*Abs has default screen layouts for abstract records and casefinding records.  Other types of 
records can be defined by your registry’s system administrator.  All record layouts can be 
customized by staff at your registry.  If you experience any problems or would like adjustments, 
please contact your registry’s SEER*Abs system administrator.  The screen shot below is of an 
abstract record using the default layout shipped with SEER*Abs. 

 

The record type is shown on the right side of the status bar (ABS in the example above).  The full 
record ID will be displayed once the new record has been saved.  A complete description of the 
status bar is provided in Section 2: Introduction to SEER*Abs.
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To create or modify a record: 

1. Open a record in the SEER*Abs Editor using one of these methods: 

a. Abstract records are typically created while completing an AFL worklist task as 
described in the Processing an AFL instructions provided in Section 3: Worklist. 

b. Or you may create a new record by selecting New Abstract, New Casefinding, or 
New <other record type> from the File menu. 

c. Saved records can be opened via the worklist as discussed in Section 3: Worklist. 

d. Or you may go directly to the SEER*Abs editor by pressing F2, using the toolbar 
icon , or by selecting Show > Editor.   To open a record in the editor: 

i. If you would like to create a new record, click the button corresponding to 
the type of record that you wish to create (Abstract, Casefinding, or a 
record defined specifically for your registry). 

ii. If you would like to re-open a record that you were working on recently, 
select it from the Recently Updated drop-down list.  The last 10 records 
that were modified in the Editor will be listed.  Records listed with an 
asterisk are In Progress. 

2. Enter data into the fields.  Refer to the subsequent sections of this chapter for an 
overview of the editor and descriptions of the controls and features.   

3. Registry-defined edits, system edits, and edit packages such as SEER edits may be 
integrated into SEER*Abs.   Edits are described in detail in the Edits to Validate Data 
section of this chapter.  To apply edits as you enter data: 

a. Configuration settings determine whether edits are executed as you move from 
one field or tab to another.  If edits do not execute as you move from field to 
field, you may click Validate to execute edits for all fields.   

b. To display a list of all edits failing for the record, click Show Errors.  The edits 
will be listed in the Message pane at the bottom of your screen. 

4. Options for exiting and/or saving changes while editing a record: 

a. Save will save changes made in the current session.  The current values in the 
record will be written to the SEER*Abs main database.  The record will remain 
open in the record editor and the record’s status (In Progress or Completed) will 
not be altered. 

b. Complete will save your changes, flag the record as a completed record, and 
close the record display. 

c. Close will close the record display.  If you have made changes that have not 
been saved, you will be asked if you want to save those changes.  The record’s 
status will not be altered.  
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d. You can actually navigate to any part of the system while you are editing a 
record.  The record will remain open in the editor.  The status bar will indicate the 
type of record, whether there are unsaved changes, and if the record has failing 
edits.  If you exit SEER*Abs you will be notified if unsaved modifications have 
been made to the record. 

To delete a record: 

1. Open a record in the SEER*Abs Editor. 

2. Click the Delete button.  A warning message will be displayed asking you to confirm the 
deletion.  Archived records have already been extracted for the purpose of updating the 
registry’s data management system.  Deleting an archived record in SEER*Abs does not 
remove it from your registry’s database.  If a record was saved and archived 
erroneously, notify your registry’s system administrator. 

Entering Values into Data Fields  

To enter values into data fields: 

• You will be able to type values directly into most fields.   

• Some fields will be auto-filled with default values based on your registry’s scripts.  The 
scripts will determine whether you can over-ride those values or not. 

• Fields with light bulbs  have a lookup table associated with them.  The lookup tables are 
defined in registry configuration files.  Click the icon or press Ctrl+L to open a table showing 
labeled values for the field.  Enter text to search by the code or label.  If you prefer using all 
keyboard controls, you can press Tab to move your cursor to the filtered list and the arrow 
keys to move through the list.  Press Enter on the highlighted row or double-click an entry 
to select the value.  Note:  Pressing Enter at any time will select a value once the list is 
reduced to a single entry. 

 

• For some fields, the value may only be changed by modifying a related field.  For example, 
the figure below shows the ID and name of the Managing Physician.  You may enter a value 
into the ID field by typing the value or using the lookup.  The name field is read only and 
will be auto-filled based on the ID.  

 

• If auto-forwarding is enabled in your registry’s configuration, the cursor will automatically 
advance to the next field when you enter the number of characters equal to the field’s 
length.  (Field length is the maximum number of characters that can be entered and may 
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differ from the size of the box on the screen.)  If auto-forwarding is on, you should only 
need to use tab to move out of fields that vary in length, for example, name, address, and 
text fields.   

• If edits do not execute as you move from field to field, click Validate to execute edits for all 
fields.  The edits are controlled by a configuration setting.  The edits may be set to execute 
as you move from one field to another; or the edits may be suppressed until you move to 
another tab or click Validate.  

Edits to Validate Data 

Registry-defined edits, system edits, and edit packages such as the SEER Edits may be used to 
validate data values while entering data into a record.  Failing edits do not prevent the record from 
being saved, completed, or closed.  When a field triggers an edit, the field is shown in red.  The 
error message is displayed if you place your cursor over the field.  Only one message is displayed if 
multiple edits are failing for the field.  All edits failing on the record are shown in the Message pane 
at the bottom of the screen (the Show Errors button toggles the display of the Message pane). 

There are two types of edits, internal system edits and edits maintained in the configuration files. 

• System Edits: A system edit indicates that the value does not conform to database or 
system rules.  For example, the value may be in an inappropriate format for the field or the 
value may not be in the field’s lookup table.  The registry configuration determines whether 
a System edit is triggered when a field’s value Examples of system edits defined in 
SEER*Abs: 

o a numeric field contains characters that are not digits 

o a Boolean field contains a value other than “0” or “1” 

o a date field is not in the “mm/dd/yyyy” format 

o a multi-line field exceeds the 30,000 character limit 

o a field contains a physician or facility ID that does not exist in the SEER*Abs 
physician or facility lists. 

o a field associated with a lookup contains a value that is not in the lookup table 

• Edits included in your registry’s configuration: These include edits defined by registry 
staff and edit packages, like the SEER Edits, that are integrated into SEER*Abs.  The SEER 
Edits are distributed with SEER*Abs, but are turned off in the default configuration settings.   

A field is highlighted in a bright red if it is failing a system edit.  A lighter shade of red is used to 
indicate that the field is failing a configuration edit (see the figure below).  To view a list of all edits 
failing for the record, click Show Errors.  This button is a toggle that shows or hides the error 
panel at the bottom of the screen.  The error panel shows the Edit ID, Group, and Message for 
each edit that is failing.  The number of edits failing in the record is displayed on the right side of 
the status bar.  If your record layout uses a tabbed interface, the number of fields related to failing 
edits is shown next to the tab name.  In the example, 3 fields are related to failing edits.  Maiden 
name and sex are related to EDIT-001; and Race 4 is related to the Field Race 4 edit.  In this 
example, there are 3 fields related to 2 edits that are failing for the record. 
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Documentation for edits can be included in the system configuration files.  There are two ways to 
view documentation related to an edit: 

• Go to the field that is failing the edit.  Press CTRL-P. 

• Or double-click the edit in the errors panel at the bottom of the screen. 
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Color Codes Used in SEER*Abs 

The SEER*Abs record editor displays data fields in different colors to highlight fields that contain 
errors and fields that have been modified but not saved.     

Colored Field Description 

 
White indicates that the field does not have an error and has not been 
changed since the last save. 

 
A dark red indicates that the field is failing a system edit. The error message 
is displayed when you mouse-over the field. 

 
A lighter red indicates that the field is failing an edit defined in the 
configuration files. The message is displayed when you mouse-over the field. 

 
Yellow indicates that the field has been changed.  The record has not been 
saved since the change was made. 

 
The field is shaded in green to indicate the current location of your cursor.  

 
Gray indicates that the field is read-only.  Read-only fields are skipped when 
tabbing during a data entry session. 

 

A combined shaded of gray and green is used to indicate that a read-only 
field has focus.  You are allowed to select a read-only field so that you can 
copy-and-paste the value of the field. 

 

Autocomplete Feature 

While entering text in a field, you may press Ctrl+Space to use the autocomplete feature.  
SEER*Abs will automatically search a list of terms based on the current word that you are typing.  
Continue typing to narrow the list of terms.  If you see the term listed, you may: 

• Continue typing until there is a single term in the list.  Press Enter.   This may be useful if 
you simply wanted to confirm spelling or syntax. 

• Or when you see the term in the list, press Tab to move your cursor to the list itself.  Scroll 
through the list using the arrow keys.  When the term is highlighted, press Enter. 
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SEER*Abs supports multiple sets of autocomplete terms.  Separate lists may be designated for 
different fields, for example, there may be one list for histology and another for primary site.  Or 
terms from all lists may be made available in a field, for example, all terms are typically made 
available when editing large text fields. 

Multi-lines text boxes 

Some fields can support multiple lines of text as shown below.    

 
Pressing Enter in a multi-line field will add a line break and your cursor will stay within the field.  To 
enter a significant amount of text into a field, press CTRL+E to open a larger text editor. 

 

The autocompletion feature (CTRL+Space) can be used when entering text in the expanded text 
editor.  Click OK to close the dialog and apply the new text to the field, or Cancel to close the 
dialog and leave the field as-is. 

Creating an Abstract from another Record  

You may create a new Abstract record based on an existing record.  You will be able to auto-fill 
selected fields by copying values from the current record into the new Abstract.  This was primarily 
designed for creating an abstract record from a casefinding record, but it can be used to create a 
second abstract record to reduce data entry for multiple primaries. 

To create an abstract from another record: 
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1. Open an existing record in the SEER*Abs Editor.   This will be referred to as the 
“original” record in these instructions. 

2. If your original record is an abstract record, click Create Copy.  If it is any other type of 
record, click Create Abstract.    

3. If you had not saved modifications to the original record, you will be asked if you would 
like to save them. 

4. If you are creating an abstract from an abstract, you may copy all data or sections of 
data from the original record into the new abstract.  A dialog like the one shown below 
will be displayed.  Select the sections of data that you would like to have copied from 
the original record into the new abstract. 

 

Using the Collaborative Stage Lookups 

SEER*Abs supports special lookups for the collaborative stage fields.  These lookups present a list 
of values based on site and histology.  If site or histology is blank in the record, the lookup will 
display a ‘?’ in the title bar and will not be able to display a list of values.  The following shows the 
lookup for CS Extension for site = C501 and histology = 8010.  Click Details to view other coding 
information for the field.  To select a value using the lookup, double-click a row in the lookup or, if 
you prefer keyboard navigation, use Tab to move to a row and press Enter.  
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Field Descriptions 

Coding information and other descriptive text can be associated with fields.  Descriptions from the 
NAACCR coding manuals are included by default for NAACCR items.  Registry staff may configure 
SEER*Abs to display descriptions for registry-specific fields.  If a description is available, the field 
label will be underlined when you mouse-over the label.  Click the label or press CTRL-N when 
editing a field to display the description. 
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Keyboard Shortcuts 

In addition to the global shortcuts, there are several shortcuts specific to editing record data.  
Press CTRL+Shift+T to view the Shortcut Help. 

Key Command Action 
Ctrl+A Create an Abstract from the current record.  You will have the ability to copy sections of 

data from the current record into the new abstract. 
Ctrl+D Delete the record currently being edited.  This is the same as clicking Delete.                                                                                                                                                                                 
Ctrl+Down Arrow
   

Go to next row in the editor.  From the last row on a tab, this goes to the first row in the 
next tab.  From the last row on the last tab, this goes to the first row on the first tab.                                                                                                                                                                                                                       

Ctrl+E  Display the Expanded text window for a multi-line field.                                                                                                                                                                                                                                                                                                                                                           
Ctrl+L           Display the field lookup if one is defined for the current field. It is the same as clicking 

the lightbulb.                                                                                                                                                                                                                                                                                                         
Ctrl+Left Arrow   Go to the previous field in the row.  From the first field in the row, this goes to the last 

field in the previous row.  This will also move across tabs.  Same as Shift+Tab.              
Ctrl+N Display documentation for the current field, if available. 
Ctrl+O            Save the record currently being edited.  Change the status to Completed.  Close the 

record.  This is the same as clicking Complete.                                                                                                                                                                                                                                                                                
Ctrl+Q            Close the record currently being edited without saving.  Same as clicking Close.                                                                                                                                                                                                                                                                                                                      
Ctrl+R            Switch between viewing and hiding the edit errors.  Same as Show/Hide Errors.                                                                                                                                                                                                                                                                                                               
Ctrl+Right Arrow  Go to the next field in the row.  From the last field in the row, this goes to the first field 

in the next row.  From the last field in the last row on the tab, this goes to the first field 
in the first row on the next tab.  From the last field in the last row on the last tab, this 
goes to the first field in the first row on the first tab.  This works the same as Tab.                           

Ctrl+S             Save the record currently being edited.  This is the same as clicking Save.                                                                                                                                                                                                                                                                                                                                      
Ctrl+Shift+Tab     Go to the previous page.  From the first page, this goes to the last.                                                                                                                                                                                                                                                                                                                                       
Ctrl+T            Validate the record currently being edited (force the edits to be recalculated).  This is the 

same as clicking Validate.                                                                                                                                                                                                                                                                                        
Ctrl+Tab          Go to the next page.  From the last page, this goes to the first.                                                                                                                                                                                                                                                                                                                                         
Ctrl+Up Arrow     Go to the previous row in the record editor.  From the first row on a tab, this goes to the 

last row in the previous tab.   This works across tabs.                                                                                                                                                                                                  
Enter             Go to the next field.  For multi-line fields, add a new line in the current field.  This is 

similar to tabbing out of the field except when in a multi-line field.                                                                                                                                                                                                                                            
Shift+Tab         Go to the previous field in the row.  From the first field in the row, this goes to the last 

field in the previous row.  This will also move across tabs.  Same as Ctrl+Left arrow.  
Tab               Go to the next field in the row.   From the last field in the row, this goes to the first field 

in the next row.  This will also move across tabs.  Same as Ctrl+Right arrow.               



24 6/12/2009       SEER*Abs User Manual  

 

Section 5:  Searching the Reference Data 
The SEER*Abs Search page allows you to search patient, facility, and physician reference data.  
Reference data are transferred from the registry’s data management database in synchronization 
processes.  Scripts maintained in the registry’s configuration define the amount and type of data 
that are made available as a reference.  These scripts can be configured to load the data directly 
from the registry’s database during synchronization; or the data can be loaded from external files.  
Your registry’s system administrator will provide you with instructions for updating the reference 
data. 

The Search page consists of three data tabs with tab-specific filters at the top of the page.  As is 
true throughout SEER*Abs, the columns and filters are defined by registry configuration settings.  
SEER*Abs is shipped with the filters and columns shown in the snapshot used in this manual. 

Searching for Patient Data 

 

The Patient Data tab can be used to search for records and consolidated patient data loaded from 
your registry’s database.  The records may have been created in SEER*Abs by you or other 
abstractors, or the records may be from other sources such as electronic pathology reports.  
Typically, records in the reference data only include records that have not been consolidated with 
other patient data in the registry’s main database.  The consolidated patient data are represented 
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as “patient sets”.  These are data that have been consolidated from abstracts, casefinding, 
pathology, and other records submitted to the registry.  In SEER*Abs, the consolidated patient 
data are known as “Patient Sets”.    

To search for patient reference data: 

1. Go to the Patient Data tab of the Search Page using one of these methods: 

a. Select File > Search Patient Data or press Ctrl+Shift+P to open the Patient Data 
tab of the Search page and clear all filters. 

b. Press F3 to return to the Patient Data tab of the Search page and restore the 
previously used filter settings and results. 

2. Enter values in the filters at the top of the page.  Your registry’s configuration determines 
which fields can be filtered.  Typically, the filters on the Patient Data tab would include 
name, Social Security Number, and other patient IDs. 

3. Click Search or press Enter to apply the filters. 

4. If the search takes too long to complete, type Escape to cancel the search.   If this is a 
continual problem, please ask your system administrator for technical support.  

5. To view data for a record or patient set, double click an entry in the results or use the up 
and down arrows to highlight the desired entry and type Enter.  You may have to use Tab to 
change the focus to the table of results before the up and down arrows will work. 

6. Click Reset to reset the filter values to blank. 

The results that match your filters will be shown in the results table.  The total number of results is 
displayed just above the table.  If you exceed the maximum number of allowed results, the 
message “(maximum number of results was reached)” will follow that number. 

Which data items are included as columns in the table of results is controlled by the configurations 
set by your registry staff, as is the format of the display.  For example, SEER*Abs is shipped with 
the columns SSN, and DOB (mm/dd/yyyy).   

The results are initially sorted based on how closely the result matches the filter, or the score.  You 
can sort by a column by clicking the column header; click it again to change from ascending to 
descending order.   Clicking Search or Clear will reset the sort order to be based on score. 

Separate layouts are defined for patient sets and records in your registry configuration settings. 
These data are displayed in read-only mode.  There is a Close button at the top right of the page. 

The snapshots below are based on the configurations shipped with SEER*Abs. 
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Facility Search 

 

The Search Manager, Facility tab is where you would go to search for information about a specific 
facility.  Much of this screen is controlled by the configurations set by your registry staff.   

Use the lookup lightbulb to change the filter settings or type directly in the filter box.  Again, the 
filters are controlled by the configuration settings, but should include information like Name and 
IDs.   After you have set the desired values, click Search to apply the filters.   If a search is taking 
too long, click Abort to cancel the request.  Click Clear to reset the filter values to blank. 

The results that match your filters will be shown in the results table below.  The total number of 
results is displayed just above the table.  If you exceed the maximum number of allowed results, 
the message “(maximum number of results was reached)” will follow that number. 

 Which data items are included as columns in the table of results is also controlled by the 
configurations set by your registry staff, as is the format of the display.  SEER*Abs is shipped with 
ID, Name, Type, FIN, NPI and Address fields.   

The results are initially displayed based on how closely the result matches the filter, or the score.  
The columns are sortable.  Click the column header to change what the data is sorted by; click it 
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again to change from ascending to descending order.   Clicking Search or Clear will reset the sort 
order to be based on score. 

To open a Facility: 

1. Go to the Search Manager (type F3; click the Search manager icon; select Search Manager 
from the Show menu) 

2. Use the filters to find the Facility you wish to view.   

3. Double click on the Facility entry in the results, or use the up and down arrows to highlight 
the desired Facility entry and type Enter.  You may have to use Tab to change the focus to 
the table of results before the up and down arrows will work. 

The layout for the facility is controlled by the configurations set by your registry staff.  It is read-
only.  There is a Close button at the top right of the screen. 

Physician Search 

 

The Search Manager, Physician tab is where you would go to search for information about a specific 
facility.  Much of this screen is controlled by the configurations set by your registry staff.  
SEER*Abs is shipped with the filters and columns shown above.  
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Use the lookup lightbulb to change the filter settings or type directly in the filter box.  Again, the 
filters are controlled by the configuration settings, but should include information like Name and 
IDs.   After you have set the desired values, click Search to apply the filters.   If a search is taking 
too long, click Abort to cancel the request.  Click Clear to reset the filter values to blank. 

The results that match your filters will be shown in the results table below.  The total number of 
results is displayed just above the table.  If you exceed the maximum number of allowed results, 
the message ‘(maximum number of results was reached)’ will follow that number. 

Which data items are included as columns in the table of results is also controlled by the 
configurations set by your registry staff, as is the format of the display.  SEER*Abs is shipped with 
ID, Name, Type, FIN, NPI and Address fields.   

The results are initially displayed based on how closely the result matches the filter, or the score.  
The columns are sortable.  Click the column header to change what the data is sorted by; click it 
again to change from ascending to descending order.   Clicking Search or Clear will reset the sort 
order to be based on score. 

To open a Physician: 

1. Go to the Search Manager (type F3; click the Search manager icon; select Search Manager 
from the Show menu) 

2. Use the filters to find the Physician you wish to view.   

3. Double click on the Physician entry in the results, or use the up and down arrows to 
highlight the desired Physician entry and type Enter.  You may have to use Tab to change 
the focus to the table of results before the up and down arrows will work. 

The layout for the facility is controlled by the configurations set by your registry staff.  It is read-
only.  There is a Close button at the top right of the screen. 
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Section 6:  Synchronizing SEER*Abs with Registry 
The Synchronization module allows you to update your copy of SEER*Abs with data from the 
registry’s main database; and it allows you to create extracts that can be used to submit your data 
to the registry.   Data imported into SEER*Abs include AFLs requiring attention and reference data.  
The reference data includes lookup tables, facility and contact lists, consolidated patient data, and 
unconsolidated patient records. 

 

Importing Data 

Data can be imported into SEER*Abs directly from a database or can be imported from external 
files.  The IT staff responsible for configuration the application should tell you which method will be 
used in your registry.  If external files will be used, please be sure you understand when new files 
will be created for your use. 

There are several types of data that can be imported. 

1. Lookup – The codes and corresponding meanings for the various fields in SEER*Abs.  This 
must be imported before you can begin using SEER*Abs. 

2. Facility – The facilities (hospitals, labs, etc) associated with your registry.  This must be 
imported before you can begin using SEER*Abs.  This allows you to indicate where you are 
collecting data when you log in, as well as capture where events occurred in the records you 
are creating. 
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3. Physicians – The physicians associated with your registry.  This should be imported before 
you begin using SEER*Abs.  This allows you to capture which doctors interacted with the 
patients in the records you are creating. 

4. AFL – Abstract Facility Leads (AFLs) represent the tasks within SEER*Abs.  An AFL should 
contain enough information about the patient (e.g. Name, SSN, DOB, etc), the cancer (e.g. 
Site, Laterality, Date, etc) and facility (Facility ID) to enable you to create the desired 
abstracts.  This should be imported before you begin using SEER*Abs. 

5. Reference Data – Data already captured in the central registry.  This would allow you to 
review what is already known about the patient and cancer before you create a new record.  
Not all registries will choose to have this information available to their abstractors.  If your 
registry does provide this information, then the reference data should be imported before 
you begin using SEER*Abs.  Reference data can include the following (as originally shipped), 
but the exact types would be controlled by the configurations set by your registry staff. 

a. Patient – the consolidated information for a patient, all their related tumors and 
whatever admission and treatment information your registry chooses to provide. 

b. Record (NAACCR) –Abstracts in NAACCR format that has arrived at the central 
registry but has not yet been processed; data that is unlinked and unconsolidated. 

c. Record (Casefinding) – Casefinding records that have arrived at the central registry 
but have not yet been processed.  These records should indicate that your registry is 
aware of a potential cancer case, but are not a full abstract. 

d. Record (HL7 E-path) – HL7 Epath records that have arrived at the central registry 
but have not yet been processed. 

e. Again, the exact components of the reference data, or even if it is available at all, 
are controlled by your registry. 

You should import data into SEER*Abs before you start to use SEER*Abs in the field.  Since the 
information in the central registry is constantly being updated, this import should be done 
regularly. 

To import data into SEER*Abs: 

1. Go to the Synchronization Manager (type F4; click the Synchronization manager icon; select 
Synchronization Manager from the Show menu) 

2. In the Import into SEER*Abs section at the bottom of the screen, use the drop-down to 
select which Method of data transfer you will use: 

a. Load from Registry Database 

b. Import from Files 

3. Check the boxes next to the Data Types to indicate which data you wish to import. 

4. If you are importing data from files, specify each file.  Click Folder icon for each data type.   
Use the browser to choose the file.   When all files have been specified, click Start Import. 
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5. If you have selected the Method ‘Load from Registry Database’, click Start Import.  You 
will be presented with a Remote Login screen.  The information about the databases you 
can connect to will be based on configurations set by your registry staff.  They should 
provide you with the information below. 

a. Select the database you wish to Connect To.   

b. Enter the username for that database (there might be a default username provided). 

c. Enter the password for that database. 

d. Click Login. 

e. The Synchronization Progress – SEER*Abs pop-up window will appear.  The 
download takes time to complete, the exact length of which will vary by how much 
data you are importing.  When the process is complete, the last line of the 
Synchronization Progress log will read ‘Done with requested scripts’. 

6. Click Close. 

Exporting Data 

Updated AFLs and completed records can be exported from SEER*Abs into external files for 
submission to the central registry or through a straight database update (the second method is not 
enabled in the default configuration provided with the application).  

To export record and/or AFLs: 

1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select 
Show -> Synchronization). 

2. In the Export out of SEER*Abs section at the top of the screen, select the method you 
would like to use to export the data. If selecting Generate Local Extracts, the filename of 
the extracts will be automatically generated.  Use the folder icon to change the output 
directory (it is currently not possible to change the filename, although that can be easily 
accomplished by renaming the file though the Operation System once the extract is 
completed). 

3. Check the data types you wish to export.  If using Generate Local Extracts, a filename 
will be assigned to each data type that is checked. 

a. The Count column displays the number of updated AFLs and completed records. 

b. It is recommended that you extract Abstracts whenever you extract AFLs and vice 
versa.   

4. Click Start Export.  SEER*Abs will execute each script and indicate whether the script 
executed successfully or if errors were encountered.   

5. Click Close. 

6. If using Generate Local Extracts, the extract files can be found in the output folder created 
when you installed SEER*Abs.  
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During the import or the export process, a progress dialog will be shown (this is true for any 
methods): 

 

While the import or export is happening, it is possible to cancel the task by clicking the Cancel 
button. SEER*Abs will try to gracefully cancelling the task; this might take up to a minute. During 
that time, the task can be terminated aggressively by clicking the Terminate button. Doing so is 
not recommended as it could generate some errors in logs. 

Viewing export/import history 

The history of all the export/import accomplished for a particular AFL, record, etc… can be viewed 
by clicking the “I” icon on the corresponding row. 

The following dialog shows two imports done by the user “depryf”: 
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The history for generating local extract also contains an extra column to recreate the extract that 
was generated at that time: 

 

When clicking the green arrow icon, the extract “abs_20090421_164025.txd” will be recreated in 
the output directory. That mechanism can be used to recreate an extract that has been lost before 
it could be submitted to the main registry. Only the last 10 extracts can be recreated for each 
method and data type. 
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Section 1:  SEER*Abs Installation

The registry’s first installation of SEER*Abs should be on the workstation of the registry’s SEER*Abs system administrator.  The system administrator will configure SEER*Abs and create a registry-specific installation file for you and other SEER*Abs users at the registry.


To install SEER*Abs on your computer:


1. The SEER*Abs software requires Java 1.6.0 or later.  Follow these steps to determine the version of Java installed on your computer:


a. Enter java -version at a DOS prompt.

b. If you do not have the required version, uninstall the existing version of Java and install the latest version. More information related to the appropriate version of Java is provided on the SEER*Abs Web site (seer.cancer.gov/seerdms/portal/seerabs).

2. Install SEER*Abs by extracting your registry’s distribution zip file into a new folder (for example, c:\seerabs).  Sub-folders within seerabs.zip must be retained.  To achieve this you may need to set an option in your decompression software (in WinZip, “use folder names” must be checked).


Section 2:  Introduction to SEER*Abs


Install your registry’s version of SEER*Abs on your laptop as described in Section 1.  The system configuration defines how patient and record data are displayed in the system, the availability of reference data, your username and initial password, and your Abstractor ID.  Please contact your registry’s IT staff for assistance with the SEER*Abs installation or to request changes to the configuration.  


Logging In


Your user name and initial password were defined by your registry’s system administrator when SEER*Abs was configured for your laptop.  If a shortcut was created, the SEER*Abs icon [image: image1.wmf] will be displayed on your desktop or in your system tray.


To log in: 


1. Click the SEER*Abs icon or double-click the seerabs.exe executable file.  SEER*Abs will load configuration files and execute initialization scripts.  You may continue with the login process as these scripts are loaded and executed.

2. Enter your username and password.  The username field will default to the username entered in the previous session.

3. If your work will be related to data for one facility, you may specify the Facility on the login page.  The value that you specify here will be used as the Current Facility in SEER*Abs.  This will be the default facility in the worklist and, depending on your registry’s configuration; it may be used as a default value for some data entry fields.  It may also be used in scripts that create extracts and download data from your registry database.  Consult the SEER*Abs system administrator at your registry to determine the ways in which Current Facility is used.   


a. To specify the Current Facility on the login page, enter the facility ID or use the lookup to search for a facility. SEER*Abs Facility IDs are the same as those in your central registry’s data management system.  If your registry uses SEER*DMS, you do not have to enter the FAC- prefix.  


b. If you are not working on data for a single facility or if you have not yet downloaded the facility list from your central registry’s database, you may leave this field blank.  (Facility lists are downloaded when SEER*Abs and your registry’s database are synchronized.)

4. Click Login.

If this is your first SEER*Abs session, you will be prompted to change your password.


1. Enter a value in Password.  Security measures to protect the confidentiality of patient data must include the use of strong passwords as described in Changing Your Password.

2. Verify the new password by re-entering it into the Repeat Password field.

3. Click OK.

Changing Your Password

SEER*Abs provides access to confidential data.  It is your responsibility to protect and maintain your password according to registry policy.  Your registry may require that you periodically create a new password.  If you have forgotten your password, please contact the SEER*Abs system administrator at your registry. 


To change your password:


1. Select File > Change Password. (Keyboard alternative:  use Alt-F to access the file menu and the down arrow key to select Change Password.)

2. Enter your Old Password.

3. Enter a New Password.  All passwords must be at least 8 characters in length.  Security measures to protect the confidentiality of patient data must include the use of strong system passwords.  Your password should:


a. Include symbols, digits, and letters of both upper and lower case.  You must use at least one lower case letter, one upper case letter, and one digit or punctuation mark.


b. Be significantly different from passwords that you have used in the past.


c. Not include your name, your username, your child’s name, or your pet’s name.


d. Not be a common word or name. 


4. Re-enter your new password in the Repeat New Password field.

5. Click OK.  Your new password will be effective immediately.

SEER*Abs Menus, Toolbar, and Shortcuts


Every item on the SEER*Abs menus can be accessed via keyboard short-cuts.  In addition, items on the Show menu can be accessed via optional toolbar icons (select Toolbar in the Show Menu to toggle the Toolbar on/off).  When logged on as a standard user, the toolbar includes four items – Worklist, Editor, Search, and Synchronization.  The menus and tools for the standard user are described in this manual.  The Configuration, Users, and Log tools are only shown when logged on as the administrative user and are described in the SEER*Abs System Administration reference.  
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File Menu


		Shortcut

		Menu Item



		Ctrl+Shift+A

		New Abstract – opens a blank abstract record in the editor



		Ctrl+Shift+C

		New Casefinding – opens a blank casefinding record in the editor.



		

		New <other record types> – SEER*Abs can be configured to create records other than abstract and casefinding.  If your system administrator configured SEER*Abs to allow data entry of other record types, they will also be listed in the File menu.



		Ctrl+Shift+P

		Search Patient Data – opens the Patient Data tab of the Search page.  The search filters are reset.



		Ctrl+Shift+F

		Search Facilities – opens the Facility tab on the Search page.  The search filters are reset.



		Ctrl+Shift+Y

		Search Physicians – opens the Physician tab on the Search page.  The search filters are reset.



		Alt+F, arrows

		Backup Main Database – creates a backup of the data stored in the main SEER*Abs database.  Data entered in SEER*Abs, changes made to AFLs, and changes made to the user list are stored in the main database.  Reference data are not stored in the main database and are not included in this backup.



		Alt+F, arrows

		Restore Main Database – overwrites the main database using a previously created backup. You will be prompted to select the backup from your hard disk or network. 



		

		Import Reference Database – overwrites the reference database using a version stored on disk. You will be prompted to select the database directory from your hard disk or network.  This feature enables you to restore a backup reference database created through external processes. (SEER*Abs does not provide an internal mechanism for creating a backup of the reference database.)



		Alt+F, arrows

		Recreate Indexes – ensures that database indexes and tables are in sync.  Indexes are used by SEER*Abs to optimize database searches.  


Recreating the indexes will ensure that the indexes and database are in sync.  It is a good first step to try if you notice odd results in searches or when filtering.  It should be very rare that this would need to be done.



		Alt+F, arrows

		Change Password – allows you to specify a new password.



		Alt+F, arrows

		Set Current Facility – allows you to change the Current Facility used throughout SEER*Abs.  You may select a facility or set Current Facility to none.  Current Facility is used as the default facility in the worklist and, depending on your registry’s configuration, it may be used as a default value for some data entry fields.  It may also be used in scripts that create extracts, download data from your registry database, or perform other functions.  Consult the SEER*Abs system administrator at your registry to determine the ways in which Current Facility is used.



		Ctrl+Shift+Q

		Exit – closes SEER*Abs.  You will be prompted to save any unsaved changes.





Show Menu


		Toolbar Icon

		Shortcut

		Menu Item



		[image: image3.png]





		F1

		Worklist – opens or returns you to the SEER*Abs worklist.  When you first login, the worklist filters are set to show outstanding abstracting tasks (AFLs) for the current facility.  AFLs for all facilities will be displayed if you do not select a current facility.   
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		F2

		Editor - allows you to create new records.  Abstract and casefinding record layouts are defined for most registries; a short abstract layout is supported but is only available if defined in your registry’s configuration.
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		F3

		Search – opens the Search page.  If you have used the Search page in this session, the filters and results most recently displayed are restored.   


Use this to search patient, facility, and physician data in the SEER*Abs database.  These reference data are extracted from the registry’s main database or loaded from external files during synchronization.  Scripts maintained in the registry’s Configuration determine the contents of the reference data. 
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		F4

		Synchronization – allows users to update SEER*Abs with data from the registry’s data management system; and create extracts to update the registry’s data management system.



		

		Ctrl+Shift+L

		Toolbar – toggles the display of the toolbar icons 





Action Menu

		Shortcut

		Menu Item



		Ctrl+Shift+H

		Purge Archived Dataa – deletes archived AFLs and/or records older than that are older than a period of time defined in registry configuration settings.  Note:  This feature may be hidden in your registry’s configuration.



		Alt+A, arrows

		Your registry’s system administrator can customize the Action menu.  Other actions may be listed.  If your registry’s configuration does not support any actions, the Action menu will not be displayed.





Help Menu

		Shortcut

		Menu Item



		Ctrl+Shift+H

		User Manual – displays this document.



		Ctrl+Shift+S

		System Administration – displays the SEER*Abs System Administration reference.



		Ctrl+Shift+T

		Shortcuts – displays a list of keyboard shortcuts.  Global shortcuts and shortcuts specific to the current page will be listed. 



		Alt+H, arrows

		Coding Manuals – Some of the SEER, NAACCR, FORDS, and Collaborative Staging coding manuals have been distributed with SEER*Abs and can be opened via the Help menu.



		Alt+H, arrows

		About – displays system information including the installed version and credits.





Status Bar

A status bar is shown at the bottom of the screen.  The contents of the status bar are described below.  


· Your username and the current facility are displayed on the left side of the status bar.  The facility will be used as the default for filters and some fields when entering data.  If you need to change the facility, select File > Set Current Facility.


· The name of the current module is shown on the far right side of the status bar.  In the example below, the user is viewing the Worklist and FAC-0009 is the Current Facility.
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· You may move back and forth from the record editor to other parts of the system without closing the record.  If a record is open in the editor:


· The type of record is indicated by an ID prefix or the full record ID.  If the record has never been saved, only the prefix is shown.  ABS and CF are the ID prefixes for abstract and casefinding records.    


· Mod is displayed if the record has been modified but not saved.


· The number of failing edits will be shown in parentheses. 


· The figure below shows the status bar as it would be displayed while editing an abstract record that was saved and then modified.  The modifications have not been saved.  The (1) indicates that there is one edit failing for the record.
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Keyboard Commands


To access a menu using your keyboard, press Alt + a letter.  To view the letter assigned to each menu, only press the Alt key.  A single letter will be underlined in each menu item.  Alt + that letter will open the menu.  You may then use arrow keys or the key combinations listed on the menu to access a specific menu item.  


In addition to the shortcuts listed in the menus and toolbar icons, there may be shortcuts designed specifically for the current page.  Enter Ctrl+Shift+T to view a list of the currently available keyboard shortcuts.


Section 3:  Worklist


The SEER*Abs worklist displays tasks related to abstracting, casefinding, and data entry.  In SEER*Abs, abstracting tasks begin as Abstract Facility Leads (AFL) and result in the creation of abstract records.  An AFL is a request to abstract medical records for a patient at a specific hospital or facility.  The AFLs are loaded into SEER*Abs based on data from your registry’s main database.  You will review the information in an AFL and, typically, create an abstract record for the patient.  


In addition to AFL tasks, all records created in SEER*Abs are listed as tasks in the worklist.  It is possible to have tasks for each type of record supported in SEER*Abs including abstract records, casefinding records, and records designed specifically for your registry.  The task ID includes a prefix which identifies the type of task.  The prefixes can be customized for your registry, if desired.  The prefixes used for tasks in the default version of SEER*Abs are:


· AFL – Abstract Facility Lead.  This “lead” indicates that an abstract is needed from a specific facility for the patient.  


· ABS – worklist task to finish an incomplete abstract record.


· CF – worklist task to finish an incomplete casefinding record.


· There may be other types of tasks unique to your registry.
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The worklist filters and columns can be configured, the worklist in your version of SEER*Abs may not be exactly as shown above.  Typically, there will be filters at the top of the worklist that allow you to search for tasks by task type, status, facility, and other search fields.  The results of your search will be displayed in the table below.  When you first log in, the worklist will display the outstanding AFL tasks for the Current Facility.

Navigation Keys for the Worklist


If you prefer keyboard navigation to using the mouse, you may use the following keys to move through the worklist and make selections:


· Tab – press Tab to move from one filter to the next.  Tab will also take you from the last filter to the Reset button, and from the Reset button to the first task in the worklist.


· Shift+Tab – use this to move in the reverse direction as Tab


· Alt+Down – to view the choices in a drop-down menu


· Arrow keys – to scroll through the choices in a drop-down menu; or to scroll through the tasks in the worklist.


· Enter – If your cursor is on a filter, pressing Enter will start the search using the settings in all filters.  If your cursor is on the Reset button, the filters will be reset to their default values.  If your cursor is on a worklist task, the task will open.

Searching the Worklist


Search criteria are entered in filters displayed at the top of the worklist.  Your registry’s system administrator can configure SEER*Abs to show different filters or change the way that the searches are implemented.  The following describes the default configuration in the distribution version of SEER*Abs.

To search for tasks in the worklist:


1. Use the drop-down menu to select the Type of worklist task.


a. AFL – a request for an abstract from a specific facility.  Data identifying the patient and the cancer of interest are defined in the AFL.


b. Abstract, Casefinding, and Other Types of Records – The worklist includes records entered in your installation of SEER*Abs. These include records that were entered but not completed, records that were completed but not submitted to the registry, and records that were submitted and archived.  Archived records are available in the worklist until they are purged using the Action > Purge Archived Data menu item.


c. Any – all of the above.  

2. Select the Status.  The values listed in the drop-down menu will vary based on the Type of task selected in step 1; you cannot filter by status if Type = Any.   Options that are enclosed in brackets are combinations of other values, for example <Outstanding> lists all open tasks for the selected data type; and <Any> lists tasks with any status for the selected data type.


a. Statuses for AFL Tasks


i. Not Processed – have not started abstracting the case


ii. In Progress – began abstracting but did not complete the abstract


iii. Abstracted – created a complete abstract record for the case


iv. Not Abstracted – determined that the case should not be abstracted


v. Archived – submitted the results of the AFL to the registry.  The status of an AFL is set to Archived when you export the AFL data.  Archived AFLs are retained in SEER*Abs for a period of time that is defined in registry configuration settings.  Archived data that have expired can be removed by selecting Action > Purge Archived Data.


vi. Outstanding – AFL tasks that have a status of In Progress or Not Processed.


vii. Any – All of the above.


b. Statuses for Record Tasks


i. In Progress – entered some but not all data in the record


ii. Completed – entered all fields and marked the record as complete


iii. Archived – submitted the record to the registry.  The status of a completed record is set to Archived when the record is exported.  Archived records are retained in the system for a period of time as defined in registry configuration settings. 


iv. Outstanding – In Progress is the only outstanding status for records.


v. Any – All of the above.

3. If you are searching for tasks related to a particular facility, enter a value in the Facility filter:


a. If you know the facility’s ID, type the ID into the filter.  SEER*Abs Facility IDs are the same as those in your central registry’s data management system.  If your registry uses SEER*DMS, you do not have to enter the FAC- prefix.  Multiple IDs can be entered separated by commas.  You may press Enter to apply your changes to the facility filter or Tab to another filter to enter additional search criteria.


b. Or click the Lookup [image: image10.wmf] to search the database for the facility ID.  


i. Enter search text into the lookup’s filter.  The lookup table and its search feature are defined by registry configuration settings.  You may sort the table of search results by clicking a column header.  


ii. Double-click an entry to select it.  If you prefer to use keyboard controls:


1. Press tab to move from the text search box to the list.  


2. Use the arrow keys to move through the list.  


3. Press Enter to select an entry.


4. The Text box is a generic, Google-style search box that can be used to search for tasks based on fields displayed in the worklist.  Registry-defined configuration scripts determine which fields are searched.


5. Press Enter to apply the filter settings.


You may click Reset to return all filters to their default values and reload the worklist.


List of Tasks


The items that match the filter settings are displayed in a scrolling table just below the filters.  The columns displayed in this table are controlled by the configurations set by your registry staff.  SEER*Abs is shipped with the columns ID, last name, first name, middle initial, SSN, Medical Record Number, Facility, Last Modified, Linked Record/AFL, and Status.   The table can be sorted by clicking the column header of any column.  Click the column header a second time to reverse the sort order.


A message is printed above the worklist table on the right side that shows the number of items displayed.  A configuration parameter determines the maximum number that will be displayed in the worklist (2,500 is the default setting).  A message will be displayed if the number of results returned by your search exceeded the display limit.  


If your search exceeded the display limit and you are looking for a particular task, it may be missing from the items listed.  You should add more detailed search criteria in the filters.  For example, if you enter a common last name into the “Text” filter and the search results exceed the display limit then you should search by SSN, facility, medical record number, or other search criteria.  


Processing an AFL


To open and process and AFL in the worklist: 

1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.)


2. Use the filters to search for AFLs from a particular facility or for a specific patient (see the Searching the Worklist section of this chapter).  

3. Use your mouse or keyboard controls to select an AFL (see the Navigation Keys for the Worklist section of this chapter).


4. Double-click anywhere on the AFL’s row or press Enter to open it.

5. The AFL will be displayed in a pop-up.  The layout of this screen is defined by your registry’s configuration settings.  The snapshot below is based on the configuration shipped with SEER*Abs.  
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6. Review the AFL and determine the appropriate action.  The Abstract button is selected, by default, when the AFL is first opened.  Use tab or your mouse to move from one button to the next. 

a. To abstract the case, press Enter or click Abstract.  SEER*Abs will open the abstract editor.  Data from the AFL and your abstractor ID may be auto-loaded into the record fields, as defined in your registry’s configuration settings.  Instructions for entering and saving the record data are provided in the Editing a Record section of this document.


b. If an abstract is not appropriate for this case, use your keyboard or mouse to select Not Abstract.  


i. Type a value or use the lookup to specify the Reason Not Abstracted.  


ii. Provide information specific to the case in the Detailed Explanation section.


iii. Click Update AFL Status to save these changes.

c. Search – Takes you to the Search module with the filters set for the patient described in this AFL.  If your registry uses reference data, this allows you to see if your registry has any information about this patient already.

d. Cancel – exit the AFL without saving any changes.


Opening a Record in the Worklist

To open a Record from the worklist in order to complete or review it:


1. Open the Worklist. (Click the Worklist toolbar icon, select Show > Worklist or press F1.)


2. Use the filters to search for the record as described in the Searching the Worklist section of this chapter.  

3. Use your mouse or keyboard controls to select a record (see the Navigation Keys for the Worklist section of this chapter for more information).  


4. Double-click or press Enter to open it.  


5. The record will be displayed in the editor.  Instructions for entering and saving the record data are provided in the Editing a Record section of this document. The editor might not be editable if the record has already been extracted out of SEER*Abs.


Section 4:  Editing a Record


The SEER*Abs Editor allows you to create or modify records.  Records can be opened and modified until they are exported (status = archived); you cannot modify data once it has been archived and you cannot use SEER*Abs to modify records that were created by other software.  Archived records can be viewed in the editor in read only mode.  Archived records are completely removed from the SEER*Abs database when the Purge Archived Data action is used. 


SEER*Abs has default screen layouts for abstract records and casefinding records.  Other types of records can be defined by your registry’s system administrator.  All record layouts can be customized by staff at your registry.  If you experience any problems or would like adjustments, please contact your registry’s SEER*Abs system administrator.  The screen shot below is of an abstract record using the default layout shipped with SEER*Abs.
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The record type is shown on the right side of the status bar (ABS in the example above).  The full record ID will be displayed once the new record has been saved.  A complete description of the status bar is provided in Section 2: Introduction to SEER*Abs.


To create or modify a record:

1. Open a record in the SEER*Abs Editor using one of these methods:


a. Abstract records are typically created while completing an AFL worklist task as described in the Processing an AFL instructions provided in Section 3: Worklist.


b. Or you may create a new record by selecting New Abstract, New Casefinding, or New <other record type> from the File menu.


c. Saved records can be opened via the worklist as discussed in Section 3: Worklist.

d. Or you may go directly to the SEER*Abs editor by pressing F2, using the toolbar icon , or by selecting Show > Editor.   To open a record in the editor:


i. If you would like to create a new record, click the button corresponding to the type of record that you wish to create (Abstract, Casefinding, or a record defined specifically for your registry).


ii. If you would like to re-open a record that you were working on recently, select it from the Recently Updated drop-down list.  The last 10 records that were modified in the Editor will be listed.  Records listed with an asterisk are In Progress.


2. Enter data into the fields.  Refer to the subsequent sections of this chapter for an overview of the editor and descriptions of the controls and features.  


3. Registry-defined edits, system edits, and edit packages such as SEER edits may be integrated into SEER*Abs.   Edits are described in detail in the Edits to Validate Data section of this chapter.  To apply edits as you enter data:


a. Configuration settings determine whether edits are executed as you move from one field or tab to another.  If edits do not execute as you move from field to field, you may click Validate to execute edits for all fields.  


b. To display a list of all edits failing for the record, click Show Errors.  The edits will be listed in the Message pane at the bottom of your screen.


4. Options for exiting and/or saving changes while editing a record:


a. Save will save changes made in the current session.  The current values in the record will be written to the SEER*Abs main database.  The record will remain open in the record editor and the record’s status (In Progress or Completed) will not be altered.


b. Complete will save your changes, flag the record as a completed record, and close the record display.


c. Close will close the record display.  If you have made changes that have not been saved, you will be asked if you want to save those changes.  The record’s status will not be altered. 


d. You can actually navigate to any part of the system while you are editing a record.  The record will remain open in the editor.  The status bar will indicate the type of record, whether there are unsaved changes, and if the record has failing edits.  If you exit SEER*Abs you will be notified if unsaved modifications have been made to the record.

To delete a record:


1. Open a record in the SEER*Abs Editor.


2. Click the Delete button.  A warning message will be displayed asking you to confirm the deletion.  Archived records have already been extracted for the purpose of updating the registry’s data management system.  Deleting an archived record in SEER*Abs does not remove it from your registry’s database.  If a record was saved and archived erroneously, notify your registry’s system administrator.

Entering Values into Data Fields 


To enter values into data fields:


· You will be able to type values directly into most fields.  


· Some fields will be auto-filled with default values based on your registry’s scripts.  The scripts will determine whether you can over-ride those values or not.


· Fields with light bulbs [image: image13.wmf] have a lookup table associated with them.  The lookup tables are defined in registry configuration files.  Click the icon or press Ctrl+L to open a table showing labeled values for the field.  Enter text to search by the code or label.  If you prefer using all keyboard controls, you can press Tab to move your cursor to the filtered list and the arrow keys to move through the list.  Press Enter on the highlighted row or double-click an entry to select the value.  Note:  Pressing Enter at any time will select a value once the list is reduced to a single entry.
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· For some fields, the value may only be changed by modifying a related field.  For example, the figure below shows the ID and name of the Managing Physician.  You may enter a value into the ID field by typing the value or using the lookup.  The name field is read only and will be auto-filled based on the ID. 
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· If auto-forwarding is enabled in your registry’s configuration, the cursor will automatically advance to the next field when you enter the number of characters equal to the field’s length.  (Field length is the maximum number of characters that can be entered and may differ from the size of the box on the screen.)  If auto-forwarding is on, you should only need to use tab to move out of fields that vary in length, for example, name, address, and text fields.  

· If edits do not execute as you move from field to field, click Validate to execute edits for all fields.  The edits are controlled by a configuration setting.  The edits may be set to execute as you move from one field to another; or the edits may be suppressed until you move to another tab or click Validate. 


Edits to Validate Data


Registry-defined edits, system edits, and edit packages such as the SEER Edits may be used to validate data values while entering data into a record.  Failing edits do not prevent the record from being saved, completed, or closed.  When a field triggers an edit, the field is shown in red.  The error message is displayed if you place your cursor over the field.  Only one message is displayed if multiple edits are failing for the field.  All edits failing on the record are shown in the Message pane at the bottom of the screen (the Show Errors button toggles the display of the Message pane).


There are two types of edits, internal system edits and edits maintained in the configuration files.


· System Edits: A system edit indicates that the value does not conform to database or system rules.  For example, the value may be in an inappropriate format for the field or the value may not be in the field’s lookup table.  The registry configuration determines whether a System edit is triggered when a field’s value Examples of system edits defined in SEER*Abs:


· a numeric field contains characters that are not digits


· a Boolean field contains a value other than “0” or “1”


· a date field is not in the “mm/dd/yyyy” format


· a multi-line field exceeds the 30,000 character limit


· a field contains a physician or facility ID that does not exist in the SEER*Abs physician or facility lists.


· a field associated with a lookup contains a value that is not in the lookup table


· Edits included in your registry’s configuration: These include edits defined by registry staff and edit packages, like the SEER Edits, that are integrated into SEER*Abs.  The SEER Edits are distributed with SEER*Abs, but are turned off in the default configuration settings.  


A field is highlighted in a bright red if it is failing a system edit.  A lighter shade of red is used to indicate that the field is failing a configuration edit (see the figure below).  To view a list of all edits failing for the record, click Show Errors.  This button is a toggle that shows or hides the error panel at the bottom of the screen.  The error panel shows the Edit ID, Group, and Message for each edit that is failing.  The number of edits failing in the record is displayed on the right side of the status bar.  If your record layout uses a tabbed interface, the number of fields related to failing edits is shown next to the tab name.  In the example, 3 fields are related to failing edits.  Maiden name and sex are related to EDIT-001; and Race 4 is related to the Field Race 4 edit.  In this example, there are 3 fields related to 2 edits that are failing for the record.
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Documentation for edits can be included in the system configuration files.  There are two ways to view documentation related to an edit:


· Go to the field that is failing the edit.  Press CTRL-P.


· Or double-click the edit in the errors panel at the bottom of the screen.


[image: image17.png]| 2| SEERABS-002 - Edit Viewer - SEER"Abs ==

Rule [szz2a25-00z]  Group [szza+25s|

Message

rimary Sive is required

Random descripvion example-

Can have list snd stusf like that:
- item 1

History.

User  Date Comment

depryf | 03/23/2006 | Codes 00-35 were expanded o 00-53.

depryf | 03/07/2003 | Codes 60-88 now valid.

depryf | 08/26/1998 _program mafie to llow 98 for cervix i st cases.
depryf | 08/12/1997  The sequence number range was expanded from 20 to 2.
depryf | 02/04/1994 The sequence number range was expanded from 15 to 20.
depryf | 12/10/1986 | The sequence number must be between 0 and 15 or 99.







Color Codes Used in SEER*Abs


The SEER*Abs record editor displays data fields in different colors to highlight fields that contain errors and fields that have been modified but not saved.    


		Colored Field

		Description
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		White indicates that the field does not have an error and has not been changed since the last save.
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		A dark red indicates that the field is failing a system edit. The error message is displayed when you mouse-over the field.
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		A lighter red indicates that the field is failing an edit defined in the configuration files. The message is displayed when you mouse-over the field.
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		Yellow indicates that the field has been changed.  The record has not been saved since the change was made.
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		The field is shaded in green to indicate the current location of your cursor. 
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		Gray indicates that the field is read-only.  Read-only fields are skipped when tabbing during a data entry session.
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		A combined shaded of gray and green is used to indicate that a read-only field has focus.  You are allowed to select a read-only field so that you can copy-and-paste the value of the field.





Autocomplete Feature


While entering text in a field, you may press Ctrl+Space to use the autocomplete feature.  SEER*Abs will automatically search a list of terms based on the current word that you are typing.  Continue typing to narrow the list of terms.  If you see the term listed, you may:


· Continue typing until there is a single term in the list.  Press Enter.   This may be useful if you simply wanted to confirm spelling or syntax.


· Or when you see the term in the list, press Tab to move your cursor to the list itself.  Scroll through the list using the arrow keys.  When the term is highlighted, press Enter.

[image: image25.png]iy Hist|

Aaite

[
lacuce
lacuce

Tymphocyoic Leukemia
Monoeysic Leukemia

Myeloid Teukemia

differencisved prograssive hisviceysosis
eryohremia

erychremic myslosiz

granulocysic leukemia

infancile reviculoendotheliosis
Leukemia

Lymphatic leukemia

Lymphoblastic leukemia







SEER*Abs supports multiple sets of autocomplete terms.  Separate lists may be designated for different fields, for example, there may be one list for histology and another for primary site.  Or terms from all lists may be made available in a field, for example, all terms are typically made available when editing large text fields.


Multi-lines text boxes


Some fields can support multiple lines of text as shown below.   
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Pressing Enter in a multi-line field will add a line break and your cursor will stay within the field.  To enter a significant amount of text into a field, press CTRL+E to open a larger text editor.
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The autocompletion feature (CTRL+Space) can be used when entering text in the expanded text editor.  Click OK to close the dialog and apply the new text to the field, or Cancel to close the dialog and leave the field as-is.

Creating an Abstract from another Record 


You may create a new Abstract record based on an existing record.  You will be able to auto-fill selected fields by copying values from the current record into the new Abstract.  This was primarily designed for creating an abstract record from a casefinding record, but it can be used to create a second abstract record to reduce data entry for multiple primaries.


To create an abstract from another record:


1. Open an existing record in the SEER*Abs Editor.   This will be referred to as the “original” record in these instructions.


2. If your original record is an abstract record, click Create Copy.  If it is any other type of record, click Create Abstract.   


3. If you had not saved modifications to the original record, you will be asked if you would like to save them.


4. If you are creating an abstract from an abstract, you may copy all data or sections of data from the original record into the new abstract.  A dialog like the one shown below will be displayed.  Select the sections of data that you would like to have copied from the original record into the new abstract.
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Using the Collaborative Stage Lookups


SEER*Abs supports special lookups for the collaborative stage fields.  These lookups present a list of values based on site and histology.  If site or histology is blank in the record, the lookup will display a ‘?’ in the title bar and will not be able to display a list of values.  The following shows the lookup for CS Extension for site = C501 and histology = 8010.  Click Details to view other coding information for the field.  To select a value using the lookup, double-click a row in the lookup or, if you prefer keyboard navigation, use Tab to move to a row and press Enter.
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Field Descriptions


Coding information and other descriptive text can be associated with fields.  Descriptions from the NAACCR coding manuals are included by default for NAACCR items.  Registry staff may configure SEER*Abs to display descriptions for registry-specific fields.  If a description is available, the field label will be underlined when you mouse-over the label.  Click the label or press CTRL-N when editing a field to display the description.
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Keyboard Shortcuts

In addition to the global shortcuts, there are several shortcuts specific to editing record data.  Press CTRL+Shift+T to view the Shortcut Help.


		Key Command

		Action



		Ctrl+A

		Create an Abstract from the current record.  You will have the ability to copy sections of data from the current record into the new abstract.



		Ctrl+D

		Delete the record currently being edited.  This is the same as clicking Delete.                                                                                                                                                                                



		Ctrl+Down Arrow



		Go to next row in the editor.  From the last row on a tab, this goes to the first row in the next tab.  From the last row on the last tab, this goes to the first row on the first tab.                                                                                                                                                                                                                      



		Ctrl+E


		Display the Expanded text window for a multi-line field.                                                                                                                                                                                                                                                                                                                                                          



		Ctrl+L          

		Display the field lookup if one is defined for the current field. It is the same as clicking the lightbulb.                                                                                                                                                                                                                                                                                                        



		Ctrl+Left Arrow  

		Go to the previous field in the row.  From the first field in the row, this goes to the last field in the previous row.  This will also move across tabs.  Same as Shift+Tab.             



		Ctrl+N

		Display documentation for the current field, if available.



		Ctrl+O           

		Save the record currently being edited.  Change the status to Completed.  Close the record.  This is the same as clicking Complete.                                                                                                                                                                                                                                                                               



		Ctrl+Q           

		Close the record currently being edited without saving.  Same as clicking Close.                                                                                                                                                                                                                                                                                                                     



		Ctrl+R           

		Switch between viewing and hiding the edit errors.  Same as Show/Hide Errors.                                                                                                                                                                                                                                                                                                              



		Ctrl+Right Arrow 

		Go to the next field in the row.  From the last field in the row, this goes to the first field in the next row.  From the last field in the last row on the tab, this goes to the first field in the first row on the next tab.  From the last field in the last row on the last tab, this goes to the first field in the first row on the first tab.  This works the same as Tab.                          



		Ctrl+S           

		 Save the record currently being edited.  This is the same as clicking Save.                                                                                                                                                                                                                                                                                                                                     



		Ctrl+Shift+Tab   

		 Go to the previous page.  From the first page, this goes to the last.                                                                                                                                                                                                                                                                                                                                      



		Ctrl+T           

		Validate the record currently being edited (force the edits to be recalculated).  This is the same as clicking Validate.                                                                                                                                                                                                                                                                                       



		Ctrl+Tab         

		Go to the next page.  From the last page, this goes to the first.                                                                                                                                                                                                                                                                                                                                        



		Ctrl+Up Arrow    

		Go to the previous row in the record editor.  From the first row on a tab, this goes to the last row in the previous tab.   This works across tabs.                                                                                                                                                                                                 



		Enter            

		Go to the next field.  For multi-line fields, add a new line in the current field.  This is similar to tabbing out of the field except when in a multi-line field.                                                                                                                                                                                                                                           



		Shift+Tab        

		Go to the previous field in the row.  From the first field in the row, this goes to the last field in the previous row.  This will also move across tabs.  Same as Ctrl+Left arrow. 



		Tab              

		Go to the next field in the row.   From the last field in the row, this goes to the first field in the next row.  This will also move across tabs.  Same as Ctrl+Right arrow.              





Section 5:  Searching the Reference Data


The SEER*Abs Search page allows you to search patient, facility, and physician reference data.  Reference data are transferred from the registry’s data management database in synchronization processes.  Scripts maintained in the registry’s configuration define the amount and type of data that are made available as a reference.  These scripts can be configured to load the data directly from the registry’s database during synchronization; or the data can be loaded from external files.  Your registry’s system administrator will provide you with instructions for updating the reference data.


The Search page consists of three data tabs with tab-specific filters at the top of the page.  As is true throughout SEER*Abs, the columns and filters are defined by registry configuration settings.  SEER*Abs is shipped with the filters and columns shown in the snapshot used in this manual.


Searching for Patient Data
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The Patient Data tab can be used to search for records and consolidated patient data loaded from your registry’s database.  The records may have been created in SEER*Abs by you or other abstractors, or the records may be from other sources such as electronic pathology reports.  Typically, records in the reference data only include records that have not been consolidated with other patient data in the registry’s main database.  The consolidated patient data are represented as “patient sets”.  These are data that have been consolidated from abstracts, casefinding, pathology, and other records submitted to the registry.  In SEER*Abs, the consolidated patient data are known as “Patient Sets”.   

To search for patient reference data:


1. Go to the Patient Data tab of the Search Page using one of these methods:


a. Select File > Search Patient Data or press Ctrl+Shift+P to open the Patient Data tab of the Search page and clear all filters.


b. Press F3 to return to the Patient Data tab of the Search page and restore the previously used filter settings and results.


2. Enter values in the filters at the top of the page.  Your registry’s configuration determines which fields can be filtered.  Typically, the filters on the Patient Data tab would include name, Social Security Number, and other patient IDs.


3. Click Search or press Enter to apply the filters.


4. If the search takes too long to complete, type Escape to cancel the search.   If this is a continual problem, please ask your system administrator for technical support. 


5. To view data for a record or patient set, double click an entry in the results or use the up and down arrows to highlight the desired entry and type Enter.  You may have to use Tab to change the focus to the table of results before the up and down arrows will work.

6. Click Reset to reset the filter values to blank.

The results that match your filters will be shown in the results table.  The total number of results is displayed just above the table.  If you exceed the maximum number of allowed results, the message “(maximum number of results was reached)” will follow that number.


Which data items are included as columns in the table of results is controlled by the configurations set by your registry staff, as is the format of the display.  For example, SEER*Abs is shipped with the columns SSN, and DOB (mm/dd/yyyy).  


The results are initially sorted based on how closely the result matches the filter, or the score.  You can sort by a column by clicking the column header; click it again to change from ascending to descending order.   Clicking Search or Clear will reset the sort order to be based on score.


Separate layouts are defined for patient sets and records in your registry configuration settings. These data are displayed in read-only mode.  There is a Close button at the top right of the page.


The snapshots below are based on the configurations shipped with SEER*Abs.


Facility Search
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The Search Manager, Facility tab is where you would go to search for information about a specific facility.  Much of this screen is controlled by the configurations set by your registry staff.  


Use the lookup lightbulb to change the filter settings or type directly in the filter box.  Again, the filters are controlled by the configuration settings, but should include information like Name and IDs.   After you have set the desired values, click Search to apply the filters.   If a search is taking too long, click Abort to cancel the request.  Click Clear to reset the filter values to blank.


The results that match your filters will be shown in the results table below.  The total number of results is displayed just above the table.  If you exceed the maximum number of allowed results, the message “(maximum number of results was reached)” will follow that number.


 Which data items are included as columns in the table of results is also controlled by the configurations set by your registry staff, as is the format of the display.  SEER*Abs is shipped with ID, Name, Type, FIN, NPI and Address fields.  


The results are initially displayed based on how closely the result matches the filter, or the score.  The columns are sortable.  Click the column header to change what the data is sorted by; click it again to change from ascending to descending order.   Clicking Search or Clear will reset the sort order to be based on score.


To open a Facility:


1. Go to the Search Manager (type F3; click the Search manager icon; select Search Manager from the Show menu)


2. Use the filters to find the Facility you wish to view.  


3. Double click on the Facility entry in the results, or use the up and down arrows to highlight the desired Facility entry and type Enter.  You may have to use Tab to change the focus to the table of results before the up and down arrows will work.


The layout for the facility is controlled by the configurations set by your registry staff.  It is read-only.  There is a Close button at the top right of the screen.


Physician Search
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The Search Manager, Physician tab is where you would go to search for information about a specific facility.  Much of this screen is controlled by the configurations set by your registry staff.  SEER*Abs is shipped with the filters and columns shown above. 


Use the lookup lightbulb to change the filter settings or type directly in the filter box.  Again, the filters are controlled by the configuration settings, but should include information like Name and IDs.   After you have set the desired values, click Search to apply the filters.   If a search is taking too long, click Abort to cancel the request.  Click Clear to reset the filter values to blank.


The results that match your filters will be shown in the results table below.  The total number of results is displayed just above the table.  If you exceed the maximum number of allowed results, the message ‘(maximum number of results was reached)’ will follow that number.


Which data items are included as columns in the table of results is also controlled by the configurations set by your registry staff, as is the format of the display.  SEER*Abs is shipped with ID, Name, Type, FIN, NPI and Address fields.  


The results are initially displayed based on how closely the result matches the filter, or the score.  The columns are sortable.  Click the column header to change what the data is sorted by; click it again to change from ascending to descending order.   Clicking Search or Clear will reset the sort order to be based on score.


To open a Physician:


1. Go to the Search Manager (type F3; click the Search manager icon; select Search Manager from the Show menu)


2. Use the filters to find the Physician you wish to view.  


3. Double click on the Physician entry in the results, or use the up and down arrows to highlight the desired Physician entry and type Enter.  You may have to use Tab to change the focus to the table of results before the up and down arrows will work.


The layout for the facility is controlled by the configurations set by your registry staff.  It is read-only.  There is a Close button at the top right of the screen.


Section 6:  Synchronizing SEER*Abs with Registry


The Synchronization module allows you to update your copy of SEER*Abs with data from the registry’s main database; and it allows you to create extracts that can be used to submit your data to the registry.   Data imported into SEER*Abs include AFLs requiring attention and reference data.  The reference data includes lookup tables, facility and contact lists, consolidated patient data, and unconsolidated patient records.
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Importing Data


Data can be imported into SEER*Abs directly from a database or can be imported from external files.  The IT staff responsible for configuration the application should tell you which method will be used in your registry.  If external files will be used, please be sure you understand when new files will be created for your use.


There are several types of data that can be imported.


1. Lookup – The codes and corresponding meanings for the various fields in SEER*Abs.  This must be imported before you can begin using SEER*Abs.


2. Facility – The facilities (hospitals, labs, etc) associated with your registry.  This must be imported before you can begin using SEER*Abs.  This allows you to indicate where you are collecting data when you log in, as well as capture where events occurred in the records you are creating.


3. Physicians – The physicians associated with your registry.  This should be imported before you begin using SEER*Abs.  This allows you to capture which doctors interacted with the patients in the records you are creating.


4. AFL – Abstract Facility Leads (AFLs) represent the tasks within SEER*Abs.  An AFL should contain enough information about the patient (e.g. Name, SSN, DOB, etc), the cancer (e.g. Site, Laterality, Date, etc) and facility (Facility ID) to enable you to create the desired abstracts.  This should be imported before you begin using SEER*Abs.


5. Reference Data – Data already captured in the central registry.  This would allow you to review what is already known about the patient and cancer before you create a new record.  Not all registries will choose to have this information available to their abstractors.  If your registry does provide this information, then the reference data should be imported before you begin using SEER*Abs.  Reference data can include the following (as originally shipped), but the exact types would be controlled by the configurations set by your registry staff.


a. Patient – the consolidated information for a patient, all their related tumors and whatever admission and treatment information your registry chooses to provide.


b. Record (NAACCR) –Abstracts in NAACCR format that has arrived at the central registry but has not yet been processed; data that is unlinked and unconsolidated.


c. Record (Casefinding) – Casefinding records that have arrived at the central registry but have not yet been processed.  These records should indicate that your registry is aware of a potential cancer case, but are not a full abstract.


d. Record (HL7 E-path) – HL7 Epath records that have arrived at the central registry but have not yet been processed.

e. Again, the exact components of the reference data, or even if it is available at all, are controlled by your registry.


You should import data into SEER*Abs before you start to use SEER*Abs in the field.  Since the information in the central registry is constantly being updated, this import should be done regularly.


To import data into SEER*Abs:


1. Go to the Synchronization Manager (type F4; click the Synchronization manager icon; select Synchronization Manager from the Show menu)


2. In the Import into SEER*Abs section at the bottom of the screen, use the drop-down to select which Method of data transfer you will use:


a. Load from Registry Database


b. Import from Files

3. Check the boxes next to the Data Types to indicate which data you wish to import.

4. If you are importing data from files, specify each file.  Click Folder icon for each data type.   Use the browser to choose the file.   When all files have been specified, click Start Import.


5. If you have selected the Method ‘Load from Registry Database’, click Start Import.  You will be presented with a Remote Login screen.  The information about the databases you can connect to will be based on configurations set by your registry staff.  They should provide you with the information below.

a. Select the database you wish to Connect To.  

b. Enter the username for that database (there might be a default username provided).

c. Enter the password for that database.

d. Click Login.

e. The Synchronization Progress – SEER*Abs pop-up window will appear.  The download takes time to complete, the exact length of which will vary by how much data you are importing.  When the process is complete, the last line of the Synchronization Progress log will read ‘Done with requested scripts’.

6. Click Close.

Exporting Data


Updated AFLs and completed records can be exported from SEER*Abs into external files for submission to the central registry or through a straight database update (the second method is not enabled in the default configuration provided with the application). 


To export record and/or AFLs:


1. Go to the Synchronization page (press F4; click the Synchronization toolbar icon; or select Show -> Synchronization).


2. In the Export out of SEER*Abs section at the top of the screen, select the method you would like to use to export the data. If selecting Generate Local Extracts, the filename of the extracts will be automatically generated.  Use the folder icon to change the output directory (it is currently not possible to change the filename, although that can be easily accomplished by renaming the file though the Operation System once the extract is completed).


3. Check the data types you wish to export.  If using Generate Local Extracts, a filename will be assigned to each data type that is checked.


a. The Count column displays the number of updated AFLs and completed records.


b. It is recommended that you extract Abstracts whenever you extract AFLs and vice versa.  


4. Click Start Export.  SEER*Abs will execute each script and indicate whether the script executed successfully or if errors were encountered.  


5. Click Close.


6. If using Generate Local Extracts, the extract files can be found in the output folder created when you installed SEER*Abs. 


During the import or the export process, a progress dialog will be shown (this is true for any methods):
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While the import or export is happening, it is possible to cancel the task by clicking the Cancel button. SEER*Abs will try to gracefully cancelling the task; this might take up to a minute. During that time, the task can be terminated aggressively by clicking the Terminate button. Doing so is not recommended as it could generate some errors in logs.


Viewing export/import history


The history of all the export/import accomplished for a particular AFL, record, etc… can be viewed by clicking the “I” icon on the corresponding row.


The following dialog shows two imports done by the user “depryf”:
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The history for generating local extract also contains an extra column to recreate the extract that was generated at that time:
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When clicking the green arrow icon, the extract “abs_20090421_164025.txd” will be recreated in the output directory. That mechanism can be used to recreate an extract that has been lost before it could be submitted to the main registry. Only the last 10 extracts can be recreated for each method and data type.
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